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Help & Support
First please read this manual thoroughly (particularly the Troubleshooting section,
if present). If a warranty is applicable, further details can be found in a Warranty
Statement at the end of the manual.

Tritech International Ltd can be contacted as follows:

Mail

Telephone

Email

Website

Tritech International Ltd 
Peregrine Road 
Westhill Business Park 
Westhill, Aberdeenshire 
AB32 6JL, UK
+44 (0)1224 744111

support@tritech.co.uk

www.tritech.co.uk

Prior to contacting Tritech International Ltd please ensure that the following is
available:

1. The Serial Numbers of the product and any Tritech International Ltd equipment
connected directly or indirectly to it.

2. Software or firmware revision numbers.

3. A clear fault description.

4. Details of any remedial action implemented.

Contamination

If the product has been used in a contaminated or hazardous environment
you must de-contaminate the product and report any hazards prior to
returning the unit for repair. Under no circumstances should a product be
returned that is contaminated with radioactive material.

The name of the organisation which purchased the system is held on record at
Tritech International Ltd and details of new software or hardware packages will be
announced at regular intervals. This manual may not detail every aspect of operation
and for the latest revision of the manual please refer to www.tritech.co.uk

Tritech International Ltd can only undertake to provide software support of systems
loaded with the software in accordance with the instructions given in this manual. It
is the customer's responsibility to ensure the compatibility of any other package they
choose to use.
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1. Introduction
The Tritech Sonar Image Tiler is designed to allow sonar images to be stitched
together into a single larger image or mosaic. This allows mapping or surveying work
to build up a complete picture of the seafloor in important areas such as harbour floors,
wreck sites or around underwater structures such as bridge and platform supports.

Note

This manual applies to software version 1.3

Hardware & Software Requirements
• A laptop, PC or SCU running Seanet Pro OR a computer running the offline

DumpLog utility and a previously recorded Sidescan log file.

• Positional data either from an external GPS/USBL linked into Seanet Pro or from
a manually entered World Position for the sonar installation.
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2. Installation
The installer file for the Sonar Image Tiler can be found on the Tritech Software
Installation CD or downloaded from: www.tritech.co.uk

The installation CD will autorun on disc insertion, first select the Seanet Pro
button to open the correct section:

Figure 2.1. Tritech Software Installation Screen

Next, select the Sonar Image Tiler button to begin the software installation.

Figure 2.2. Select Sonar Image Tiler
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Note

If installing from the Internet an executable file called
ImageTilerSetup.exe will be downloaded. Run this file and follow
the on-screen instructions.

Upon installation a program icon will be created on the Windows desktop and a
Tritech Image Tiler folder will be added to the Windows Start menu.

Figure 2.3. Desktop Icon
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3. Supported File Formats

3.1. For Loading Tiles
In order to correctly position the images each image tile file should be accompanied
by an equivalent "world file" which contains positional data. This data should come
from a GPS linked into Seanet Pro. If a GPS is available Seanet Pro will automatically
create a world file with the correct data when a Snapshot is taken.

The following file formats are supported:

Image Type World File
.bmp .bpw
.jpeg/.jpg .jgw
.tiff/.tif .tfw
.png .pgw

Note

The image file and world file should have the same filename (i.e.,
sonar.bmp and sonar.bpw).

Note

The image tiles have to be saved from the latest version of Seanet Pro; if
an older version is used they will not open in the Sonar Image Tiler. If
in doubt, remove the current version of Seanet Pro and either download
the latest version from www.tritech.co.uk or re-install from the CD-ROM
which contained the Image Tiler installation program.

3.2. Saving Images or Mosaics
Saving an image can either be the whole chart (with any visible tiles or markers), a
marked out section or a mosaic of tiles either way the supported formats are:

.bmp Bitmap image

.kmz Google Earth format

.png Portable Network Graphic

Note

The Sonar Image Tiler will automatically create at matching world file
for the saved image.
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3.3. Project Files
The Sonar Image Tiler uses a customised XML format for saving and loading
projects. These project files will preserve any tile data or marker data so that they can
be manipulated again at a later stage or transferred to another computer for editing.

Note

Due to the fact that the project files contain the data for all the tiles, if the
project has many tiles it can result in the production of large XML files.

3.4. Marker Files
Two different marker file types are supported both of which are in CSV format but
with different filename extensions and different complexity:

.mrk Seanet Pro full length marker files.

.csv A shortened version of the Seanet Pro format.

Note

For full details of the marker file formats please see Appendix A, Marker
Files.
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4. Hammerhead Sonar Image Capture
This manual only describes the procedure for capturing sonar images and assumes
that sonar operation and installation (including any GPS setup) has already been
covered. The example is for a Tritech International Ltd SeaKing Hammerhead Sonar.
If other sonar heads are to be used then please contact Tritech International Ltd for
details on how to configure them.

4.1. Setting up Seanet Pro

By default the Hammerhead installation of Seanet Pro is set up for Single Sonar.
If this has been changed for any reason, return to the default setting so that the main
screen shows sonar, attitude and compass displays.

In the top left click on the Settings button and then click on Installation:

The Installation page allows geo-referencing to be applied for either GPS
Position Updates (which requires an enabled GPS input) or from a manually
entered Fixed Position:
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If there is a MicronNav system installed with the Hammerhead the USBL position
updates can be applied instead. Select From USBL Position Updates and
select the appropriate Unit ID corresponding to the device to be used to input the
positional data (R0 is the Responder and T1-T15 are the Transponders - the menu
will only display those devices which are available).

If the Fixed Position option is selected this data can be acquired from either
the GPS or USBL position without having to manually enter values. Use the Set
Fixed From GPS and Set Fixed From USBL buttons.

The Hammerhead can use its internal compass for the Heading and to North-correct
captured images. For the internal or a secondary compass attached to the sonar AUX
port select Internal/Aux Compass. The USBL also has a compass that can be
used by selecting Ship/USBL Compass if a MicronNav system is connected. If no
MicronNav is available the vessel's compass can be used; connect to the computer via
an available COM port and configure using the Utilities menu and Com Setup
option.

To capture sonar images at any time click on the Snapshot button to save
the bitmap. If GPS/USBL data is present or a Fixed Position has been entered
a World File will also be created in the same folder as the Image file.

Clicking on Snaphot will open the Save to Bitmap dialog where a folder can
be selected and the image file named. Click on Save as Type to select either a
.bmp or a .tiff image format
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Note

The filename will default to include the current time and sonar
configuration details.

Note

The dialog box can be suppressed by enabling the Quick Print
button. The current folder, last selected image file type and default naming
convention will then be used automatically every time the Snapshot
button is pressed.
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5. SeaKing Sidescan Image Capture
The Sidescan and GPS data first has to be recorded into a log file (.v4log) using
Seanet Pro. This log file is then opened in the DumpLog offline utility program
and a GeoTiff output is created. This GeoTiff output will also contain a World File
assuming that there is valid GPS data within the log file.

For the latest version of the DumpLog utility please visit: www.tritech.co.uk

Run DumpLog and click on Open File(s)

Select the log file or files that are to be converted.

Select the GEOTIFF output format and then tick the Sidescan and GPS device
boxes as shown below:
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Note

If the indicators next to the Sidescan or GPS boxes are not illuminated
red after opening the log file it indicates that there is no matching data. If
this is the case it will not be possible to create a GeoTiff and World File
output for use with the Image Tiler.

There are several TIF and GeoTiff settings that can be altered by clicking on
Options and selecting the TIF/GEOTIFF tab page.

The main settings are for a Colour Scheme to be applied to the output sidescan
imagery and a choice of methods to apply heading/course correction to the output
file. The Beam Width sets the width of each scan line which can help with gaps
that may occur, particularly when cornering.

Once setup is complete click on Convert File(s) to create the output. This
will create .TIF (GeoTiff image) and .TFW (World File) files which can then be
imported into the Sonar Image Tiler.
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6. Software Functions

6.1. Toolbar

Import chart
Export as image
Save project
Load project
Clear project
Add tile
Delete all tiles
Reset all tiles
Resize tile
Create mosaic
Save mosaic
Zoom in
Fit to screen
Zoom out
Toggle coordinates dialog
Toggle coordinate system dialog
Toggle tile list dialog
Toggle chart
Show markers
Move marker
Pan tool
Erase tool
Area erase tool
Remove tile background
Export area

6.1.1. Project Controls

Import/Create Chart

For creating a blank chart or importing a previously created chart. For more
information on this function please see Section 7.2, “Create the Background Chart”.
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Export As Image

If an area is selected this button will export the selected area. If no area is selected
the whole chart will be exported.

For details of the supported file format please refer to: Section 3.2, “Saving Images
or Mosaics”.

Note

The markers will be embedded into the image file and if the image is
loaded again it will no longer be able to modify or hide them. If exporting
the image to use again as a chart the markers should first be hidden (see
Section 6.7, “Using Markers”).

Save Project

The first time this is pressed it opens a dialog to name and then save the current state
of the chart, tiles and markers as an XML file. Using this option allows the project to
be loaded later and the markers or tiles moved or hidden.

Subsequent presses of the button will not prompt for a filename and instead save over
the existing project - to save under a different name navigate to the File menu and
select Save Project As....

Note

If the tiles have been moved or rotated away from their original positions
it will no longer be possible to restore them after the Project has been
saved, i.e., the new "original" position which they will be returned to when
they are "reset" will be the position which they were in when the Save
Project button was pressed.

Load Project

For loading a previously saved Project file. The files are only generated by the Sonar
Image Tiler and are in XML format.

For details of the supported file format please refer to: Section 3.3, “Project Files”.

Clear Project
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Removes any loaded data and clears the workspace. Any unsaved data will be lost.

6.1.2. Tile Controls

Add Tile

Opens a dialog to load an image tile. Image tiles must be in the correct format and
have an associated world file.

For details of the supported file format please refer to: Section 3.1, “For Loading
Tiles”.

Delete All Tiles

Removes all the tiles from the chart. Any unsaved changes will be lost

Note

To delete a tile individually use the Tile List as detailed in Section 6.6,
“Tile List Dialog”.

Reset All Tiles

Resets all the tiles using the position, orientation and size from when they were first
loaded.

If the tiles were loaded as part of a project then they will be reset to the original state
that they were when the project was saved.

Note

To reset a tile individually use the Tile List as detailed in Section 6.6,
“Tile List Dialog”.

Resize Tile

Tiles can be resized individually using this tool. When the tool is enabled each tile
will show a thin red outline with anchors at the corners and side midpoints. The
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mouse pointer will change to arrows indicating the available resize direction when
it is positioned above the resize points. Click, hold and drag to resize the tile. The
corner anchors maintain aspect ratio while it is resized whereas the side anchors allow
the image to be stretched.

Create Mosaic

This will stitch all the visible tiles together into a single image. If only some of the
tiles are to be included the remaining ones should be hidden from view using the
Tile List as detailed in Section 6.6, “Tile List Dialog”.

Save Mosaic

Saves the newly created mosaic as an image with an accompanying world file which
can then be loaded as a tile for future Projects.

Using the Save Mosaic function has the advantage over Create Mosaic in
that it does not alter the tiles within the project so they can still be modified if desired.
The newly created mosaic is in a completely separate file.

For details of the supported file format please refer to: Section 3.2, “Saving Images
or Mosaics”.

6.1.3. Zoom

The zoom controls allow the user to Zoom In on an area of the screen by using the

button  or by scrolling the mouse wheel forward.

Similarly, zooming out can be accomplished using the Zoom Out button  or
scrolling the mouse wheel backwards.

The view can be reset so as the chart fits into the window by pressing the Fit To

Screen button 

6.1.4. View/Hide Controls

These controls are the same as those found in the View menu and allow the different
dialogs to be shown or hidden from the workspace.

The background chart can be hidden to allow better viewing of the individual tiles by

selecting the View/Hide Chart button: 
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For more detail on the functionality of the dialogs refer to Section 6.5, “Information
Dialogs” and Section 6.6, “Tile List Dialog”.

6.1.5. Markers

Using these buttons the markers can be shown, hidden or moved. For a full description
of the use of markers see Section 6.7, “Using Markers”

6.1.6. Tile Manipulation

Pan Tool

The pan tool is the default operation and allows the current viewpoint to be moved
around by clicking and holding the left mouse button - useful if zoomed in or using
a very large chart.

When this tool is selected and the mouse pointer is hovered over the tile handles the
functionality will change to that of move a single tile or rotate the tile (depending on
where the mouse pointer is located).

Note

This tool does not alter the position of the chart - it simply changes the
visible portion on the screen.

Erase Tool

Note

This action cannot be undone. To restore the original tile the tile has to be
deleted and then added afresh.

This tool allows parts of the sonar tile to be removed manually as if using an eraser.
To remove a section of sonar tile select this tool then click and drag the left mouse
button over the desired area. When this tool is active the mouse cursor should change
to an eraser.

If multiple tiles are overlapping the erase tool will work on the uppermost tile only
but if a portion is already erased the eraser will start to erase the tile below as well.
To avoid accidentially erasing the wrong tile, it is recommended that the tiles that are
not being worked on are disabled or hidden using the Tile List (see Section 6.6,
“Tile List Dialog”).
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Area Erase Tool

Note

This action cannot be undone. To restore the original tile the tile has to be
deleted and then added afresh.

This tool erases polygonal-shaped sections from the sonar image tile. To use it select
the tool then click (and release) on the sonar tile, move the mouse and click again to
add another point (the points will be joined by a red line). Keep adding points until
the desired shape has been constructed and then double-click to close the area (i.e.,
the last added point will be joined to the first point with a straight line). When the
area is closed the polygon that is created will be automatically deleted from the tile
and the red outline will also disappear. While this tool is active the mouse cursor will
change to a cross-hair with polygon shape.

All visible tiles that intersect with the defined polygon will have a section deleted. To
make sure that some tiles are preserved, first hide them from view - see Section 6.6,
“Tile List Dialog”.

Crop Background

Note

This action cannot be undone. To reset the tile, it must be deleted and
added again as if it is new.

To control the amount of sonar data displayed in a tile the automatic background
removal tool uses an intelligent algorithm to determine unwanted sections and remove
them from the tile. Unwanted background pieces are those that are typically around
the edge of the sonar scan and do not add any detail to the images. In general, acoustic
shadows around areas of high intensity should be kept as they add detail and context
to the image.

6.1.7. Image Export Area

The Image Export Area selection tool enables restricted areas of the workspace to
be exported to an image file. The mouse pointer will change to a cross-hair for more
accurate selection. To use, simply draw a box around the area to be exported and then

press the Export As Image button ( )
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Note

Only when this button is enabled will the selection be used as the export
area, otherwise the entire chart will be used.

6.2. Moving tiles

The Pan Tool button  has to be selected for this function to work.

When the mouse pointer is over the centre of the tile it will change to a hand icon.
Hold down the mouse button to drag the tile and position it correctly.

6.3. Rotating tiles

The Pan Tool button  has to be selected for this function to work.

A tile can be rotated by selecting and moving the rotation lever (see Figure Figure 6.1,
“Rotating the Tile”). The mouse pointer will change to show a hand with rotation
arrows when it is positioned above the end of the lever. Holding the mouse button
down and dragging in a circular motion will rotate the tile:

Figure 6.1. Rotating the Tile

The amount of rotation will be displayed in the Tile List panel (which can be
displayed using the View menu and selecting Tile List).
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The colour of the rotate handle can be changed by navigating to the Tools menu
and selecting Options

6.4. Mosaic of Tiles
To create a mosaic of tiles it will be necessary to have multiple tiles together within
a single geographic region. It will not be possible to create a mosaic if the tiles are
very far apart, likely as a result of having an incorrect or corrupt world file which
results in their incorrect placement.

Creating a mosaic is a simple process, first arrange the tiles as desired and hide tiles
that are not going to be included in the final mosaic, then press the mosaic button

on the toolbar ( ) which will start the mosaicking process. An example of this is
presented in Figure 6.2, “Mosaicking Tiles”.

Note

The mosaicking process is irreversible and will result in a new tile created
which cannot be split into the original tiles. To restore the original tiles
they will have to be re-loaded.

Figure 6.2. Mosaicking Tiles
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Note

If Save Mosaic is pressed instead the output will not be on the screen
but to a file so a file chooser dialog will present itself.

6.5. Information Dialogs
There are also three information panels accessible from the toolbar or the View menu:
the tile list; mouse position; and the coordinate system used. Both the tile list and the
mouse view display the position of tile centres or mouse pointer, respectively, using
the selected coordinate system.

Coordinate System

The Coordinate System display can be viewed and controlled by selecting

the button  or using the View menu and select Coordinate System option.
This allows the user to choose between using Decimal Degree, Degrees and
Decimal Minutes, Degrees, Minutes and Seconds and Universal
Transverse Mercator (UTM). Selecting one of these options automatically
updates the display in the both the Mouse Position and Tile List display
panels.

Mouse Coordinates

The Mouse Coordinates display is also controlled from the View menu and

View button collection  . It shows the mouse position in the context of the chosen
coordinate system.

6.6. Tile List Dialog
The Tile List panel can be made visible using the View menu and selecting the
Tile List option.

Alternatively the Tile List can also be viewed using the button: .

Action on Multiple Tiles

By holding down the shift key on the keyboard it is possible to select
multiple tiles in the Tile List and move them up/down the layers
together, show/hide them as a group or delete/reset multiple tiles in one
go.
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Saving the tile will only work on one tile at a time.

Layering tiles

Layering the tiles determines the order in which they are displayed, i.e., tile 1 is
displayed in front of tile 2. The order can be changed by moving tiles up and down
in this list, either as individual tiles or in groups.

Note

If centre marks or rotation handles obscure one another interaction will
occur using the lowest numbered (corresponding to the topmost) tile so it
may be necessary to re-order the tiles to gain access to the handles.

Click on the row containing a tile to highlight it and then press either the UP or DOWN
arrow to bring the image forward or backward on the display by one layer.

Multiple tiles can be moved in one go by selecting each one and holding down the
control key on the keyboard (or by selecting a span using the shift key). Once
selected the tiles can be dragged as a group by holding down the mouse button and
moving up or down the list to re-order them.

The tiles will be automatically renumbered with the lowest number being the first
one displayed.

The tiles can also be controlled using a menu that is accessible by clicking on the tile
entry in the list with the right mouse button. Using this method the tile can also be
moved immediately to the front or the back of the display stack.

Save Selected Tile

Saving a tile will export it with a new world file so that any changes that have been
made to the position or orientation can be preserved.

Delete Selected Tiles

Deleting a tile will permanently remove it from the display. Any changes made to
it will be lost.

If multiple tiles are selected when this button is pressed they will all be deleted.
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Reset Selected Tiles

Resetting a tile changes the tile location, orientation and size to the coordinates and
rotation value contained in the world file that was originally used to load the tile. Any
subsequent movements or rotations that have been made are lost.

If multiple tiles are selected when this button is pressed they will all be reset.

Note

If a project has been loaded the tile will be reset to the orientation when the
project was loaded. The process of saving the chart and tiles as a project
removes the original tile data so the only way to restore the original tile
would be to delete it and reload it.

Show/Hide Selected Tiles

Tiles are hidden by de-selecting the check box to left of the tile number.

If multiple tiles are selected when this button is pressed they will all be shown/hidden.

6.7. Using Markers

The Image Tiler has the ability to import a marker file which has been saved from
Seanet Pro (marker files have the extension ".mrk") or from a CSV text file (full
details of the marker files are in Appendix A, Marker Files).

First create the marker file from the chart in the MicronNav application in Seanet
Pro. Then open the marker file by navigating to Import Marker File from the
Tools menu.

The imported markers will be overlayed on top of the chart:
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The positions of the markers is shown next to the location. Markers can be hidden

using the button on the toolbar: .

To move a marker first select the move marker button ( ) and then click on the
marker and drag it to the new location.

Note

If markers are displayed and Export as Image is selected they will
be merged with the background. If the chart is to be used again it will
not be possible to move or remove the markers. For this functionality
the chart should be saved without the markers or with them hidden. If
Save Project is selected the chart, tiles and markers are all saved as
individual entities and can be interacted with as normal.



Sonar Image Tiler

0706-SOM-00002, Issue: 04 27 © Tritech International Ltd.

7. Creating the Mosaic Image

Figure 7.1. Completed Mosaic

A mosaic as shown in Figure Figure 7.1, “Completed Mosaic” can be created with
the Sonar Image Tiler using a background chart, and sonar image tiles with their
associated world files. The user must first set a background to place the image tiles.
This background is called a "chart"; although if an actual survey chart is not available
a blank canvas can be used. There is also the option to use the first added tile
as a reference. All image tiles and background chart or blank canvas require geo-
referencing. This is done during the creation of the chart by entering Position
Co-ordinates for the top-left corner and a chart Width and Height.

With a background chart in place the sonar image tiles can then be loaded and any
position or rotation corrections made. The entire chart and tiles, or a selected area,
can be exported as an image file and a (separate) world file.

This chapter is organised into sections explaining the process of creating a mosaic,
the tools available to the user, and also exporting an image or saving the project.

Note

Load Project allows a previously created chart, collection of tiles
and markers to be loaded for further editing or for selecting an area to be
exported as a bitmap.

7.1. Overview of Process

Prior to starting the mosaic process it is necessary to obtain the following:
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• An image with GPS data in an associated world file to use as a background. Or
appropriate GPS coordinates and geographical dimensions sufficient to encompass
all of the sonar image tiles if creating the chart manually.

• A set of sonar image tiles from a Seanet Pro session which include GPS data in
accompanying world files.

Given data already created using Seanet Pro the process for tiling images into a
mosaic is as follows:

1. Create a chart: either from an image, import a previously created chart or create
a blank chart from GPS data.

2. Load sonar image tiles onto the chart.

3. Manipulate the image tiles to the correct position (if required).

4. Either export the resulting mosaic as a bitmap (with world data) or save as a project
(containing a chart and a collection of tiles) to work on again later.

7.2. Create the Background Chart
The Sonar Image Tiler starts with a blank screen:

First create a chart background onto which the sonar image tiles will be placed.
If Seanet Pro is running on the PC and has a chart configured as part of its Nav
application then you can select it using the Files menu and Open Seanet Chart
option. If no Seanet chart is available click on the Import/Create Chart button

 to set up a new chart background.

Note

It is also possible to use the first tile as the chart background - see below
for the procedure for adding tiles. This tile cannot be moved or rotated
and acts as the fixed reference point for other tiles.

In the Add Chart dialog box there are three options for adding or creating a chart.
The user can select to use an image with associated world file; an image with manually
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entered position and scale; or a blank chart with manually entered position data. These
options are explained further in the following sections.

7.2.1. Image with World File

Select Import World File for the Open World File dialog and select the
appropriate world file. The format of the world file can be either .bpw (bitmap), .jgw
(jpeg), .tfw (tiff) or .wld (generic/CAD).

The world file format for x and y co-ordinates can either be in Eastings/Northings (E/
N) or Longitude/Latitude (L/L). If co-ordinates are in E/N then a Zone will need to
be entered and a reference Ellipsoid selected (for definition of latitude, longitude
and elevation).

Verify chart parameters are correct and click OK to confirm and load this chart onto
the display.
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7.2.2. Image with Manual Positional Data

First, select Open Image button to bring up the Open Chart dialog and select
the required chart image. The image format can either be .bmp (bitmap), .jpg (jpeg)
or .tif (tiff).

Note

Where an associated world file (matching name) is detected in the same
folder as the selected image the chart parameters will automatically be
loaded.
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Next, enter the Point of Origin co-ordinates and the chart Dimensions.
If the Universal Transverse Mercator (UTM) coordinate system is used a reference
Ellipsoid will also have to be selected at this point (the default is WGS84 (World
Geodetic System 1984)).

7.2.3. Blank Chart

Select Use Blank to create a blank image for the chart background. A default width
and height will be set.

The Point of Origin co-ordinates and the chart Dimensions will have to
be set. If UTM then also select a reference Ellipsoid at this point (the default is
WGS84).

7.2.4. Co-ordinate System

When creating charts the Point of Origin co-ordinates will be in the format
that is currently selected in the Coordinate System panel. To change this select
Cancel and navigate to the Coordinate System control (if this is not visible
go to the View menu and select Coordinate System).
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7.3. Add Image Tiles

Once the chart background has been loaded sonar image tiles can be added. Tiles
must be within the same geographic area of the chart background.

Either click on the Add Tile icon,  or add the tile through the Tools menu
and Add Tile option.

• A dialog enabling searching and adding of images is shown. The images can
be in .bmp (bitmap), .jpg (jpeg) or .tif (tiff) formats. A matching world file is
required in the same folder or the image will not load.

• The tile will be added on top of the chart if the geographic co-ordinates are within
the background area.

• Simply repeat these steps to add further tiles.

Note

Several files can be added at the same time by holding down the Ctrl
key whilst selecting the images.

7.4. Manipulate Image Tiles

The position information for tiles is dependent on the settings when the tile scans
were created.

If the imported position is incorrect the tiles can be repositioned on the chart at any
point after they have been added to provide a more accurate mosaic. There are several
repositioning functions available: moving, rotating, and resizing. As well as tools to
alter the appearance of shadows in tiles: automatic cropping of unwanted shadows,
manual eraser, and area erase.

For full details of the possible ways to manipulate the tiles please refer to Chapter 6,
Software Functions

7.5. Save the Project

Save Project allows the chart to be saved as a chart and a collection of tiles (and
any markers) so it can be loaded for editing at a later date. The user is prompted for
a file name, with the file type being XML.
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7.6. Exporting the completed mosaic as an image
Charts can either be exported whole or areas can be selected and saved. To export
the entire image simply select Export as Image from the Files menu. This
will then display a dialog prompting for the desired location and name of the file.
This output image will have an associated world file so it can be imported into other
software packages with the geo-referencing intact.

Note

If there is an area selected on the chart, clicking Export as Image
will only save what is contained within the selection region. The format of
the saved chart will depend on the format of the input chart (i.e., a .bmp
input will generate a .bmp output).

To create an output image using the Selection Tool follow these steps:

First click on the Image Export Area button: 

Using the left mouse button click and hold anywhere on the chart and then drag the
cursor across the screen to create a selection area.

Click on the Files menu and go to Export as Image. Enter a filename and
select the desired file type (.jpeg, .bmp or .tiff) then click Save. A world file will be
created with the same filename as the image file.

Note

There will also be a .kmz file created. This is a Google Earth file format
and will allow the image to be viewed in Google Earth.
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Selection area within dotted line  Output image

Note

It is also possible to output just the tiles (i.e., without the background

chart) by clicking on the Save Mosaic button: 
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8. Example: Using Sidescan Image Tiles
Several .v4log files have been created in Seanet Pro that contain SeaKing Sidescan
and GPS NMEA data. Each file contains the sidescan data for one track from a
lawnmower style survey. GeoTiff files (and corresponding world files) were created
using the DumpLog utility and these file-sets were added/imported into the Image
Tiler application as sonar image tiles.

The files used for this example were as follows:

GeoTIFF file: Outfall3.TIF
World File: Outfall3.TFW

Outfall3.TIF image, ©Cawthron

Contents of
Outfall3.TFW:

0.0121457489878543
     0
     0
     -0.121457489878543
     299883.8970386512
     4836012.20188229
     

Outfall4.TIF image ©Cawthron

Contents of
Outfall4.TFW:

0.0121457489878543
     0
     0
     -0.121457489878543
     300067.466645638
     4835950.35472915
     



Example: Using Sidescan Image Tiles Sonar Image Tiler

0706-SOM-00002, Issue: 04 36 © Tritech International Ltd.

The TIF and TFW file sets were imported into the Sonar Image Tiler using the Add
Tile button. The first tile imported was used as the reference background image.
Further tiles were added and repositioned.

With the image tiles added an area was highlighted using the Selection Tool
and the area was saved to file using the Export Chart as Image button. The
saved image mosaic appears as follows:

Sidescan Images provided courtesy of Cawthron, New Zealand (image shows mega
ripples of sand off the coast of Foveaux Strait near Bluff)
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9. Troubleshooting
The following table outlines some problems which can readily be fixed by altering
settings or other simple procedures. If any of these solutions do not solve the problem
please contact Tritech International Ltd using the contact details listed in the Help &
Support Section at the start of this manual.

No World File created by Seanet
Pro

This is likely caused by a lack of GPS/USBL
data.

If using a GPS/USBL ensure that they are
connected and set up properly

Check the Installation page to make
sure that the correct positioning device is
being selected, or that Fixed Position is
selected.

Snapshot captures entire Seanet
Pro screen

Incorrect registry setting.

Modify the Windows registry using
regedit.exe to ensure that the following setting
is applied:

HKEY_CURRENT_USER\Software\System
Technologies\SeaNet\ScrnCapSonarOnly = 1
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Appendix A. Marker Files
Seanet Pro includes the facility to lay a series of markers to label and track objects,
points of interest and way positions. These markers can be saved to file for the purpose
to re-load at a later date, to form part of a report or for use with the Sonar Image
Tiler program.

There are two formats of marker file:

1. A full, comma separated file format with the filename extension .mrk

2. A shortened, comma separated format with the filename extension .csv

Full Marker File Format (.mrk extension)

This is the format that is native to Seanet Pro and includes full details of the marker
configuration. The file is in an ASCII Comma Separated format and contains the
following fields:

IndexValue Description
1 ID This is a unique string ID. It comprises a 2 letter header

("mk") followed by a DateTime code. Any unique string
value is acceptable.

2 Group This is unused and should be set to 0.
3 X Coordinate For the .mrk file this will always be output in UTM

Easting.
4 Y Coordinate For the .mrk file this will always be output in UTM

Northing.
5 Altitude This is UTM Altitude and is currently unused.
6 UTM Zone Parallel Zone latitudinal letter (e.g. 'C' through 'X').
7 UTM Zone

Meridian
Zone longitudinal number (e.g 1 through 60).

8 UTM Ellipsoid Ellipsoid code (0 = Airy, 1 = Australian National, 2
= Bessel1841, 3 = Clarke 1866, 4 = Clarke 1880, 5 =
Everest, 6 = GRS80, 7 = International 1924, 8 = Modified
Airy, 9 = WGS84).

9 Point Size Applies to Circle, Square & Triangle shape types only,
otherwise set to 0.

10 Date & Time Date & Time in English(GB) Locale.
Format is "dd/mm/yyyy hh:mm:ss"

11 Shape Type 0 = Circle, 1 = Square, 2 = Triangle, 3 = Sonar Range, 4
= Preset Image (see Image Info below).



Marker Files Sonar Image Tiler

0706-SOM-00002, Issue: 04 39 © Tritech International Ltd.

IndexValue Description
12 Shape Colour Applies to Circle, Square and Triangle shape types only,

otherwise set to 00000000 (32 bit RGBA).
13 Font Inner Colour Applies to Comment Text (32 bit RGBA).
14 Font Outer Colour Applies to Comment Text (32 bit RGBA).
15 Marker Bitwise Bit 1 = Show Marker, Bit 2 = Show Coordinates, Bit 3 =

Show Comment Text (i.e. 00000111 = Show All).
16 Image Info Presets = Red Flag, Blue Flag, Green Flag, Buoy, Anchor,

Rock, Danger, POI, ViewPort, Sonar, Diver, Wheel,
Comment or MLO
Alternatively can be full path and name of an image file
(e.g. 'C:\Image1.bmp').

17 Comment Comment text.

For example, the following two markers would produce a two line .mrk file as shown:

mk41149.5595988657,0,548699.614997778,6313221.96999907,-5.3544902067987E-76,V,30,9,0,
   28/08/2012 13:25:51,4,00000000,00FFFFFF,00000000,7,Red Flag,Possible Wreck Site
mk41149.5605201736,0,548724.213265236,6313198.87994614,-5.3544902067987E-76,V,30,9,0,
   28/08/2012 13:27:48,4,00000000,00FFFFFF,00000000,7,Rock,WARNING! ROCKS
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Shortened Marker File Format (.csv extension)

This file format is a more concise and usable format, particularly for loading a pre-
defined target list into Seanet Pro. The file is in an ASCII Comma Separated format
and contains the following fields:

IndexValue Description
1 ID This is a unique string ID. It comprises a 2 letter header

("mk") followed by a DateTime code. Any unique string
value is acceptable.

3 X Coordinate For the .csv file, will be in coordinate system used in
Seanet (either Longitude or UTM Easting).

4 Y Coordinate For the .csv file, will be in coordinate system used in
Seanet (either Latitude or UTM Northing).

17 Comment Comment text.
11 Shape Type 0 = Circle, 1 = Square, 2 = Triangle, 3 = Sonar Range, 4

= Preset Image (see Image Info below).
16 Image Info Presets = Red Flag, Blue Flag, Green Flag, Buoy, Anchor,

Rock, Danger, POI, ViewPort, Sonar, Diver, Wheel,
Comment or MLO
Alternatively can be full path and name of an image file
(e.g. 'C:\Image1.bmp').

10 Date & Time Date & Time in English(GB) Locale.
Format is "dd/mm/yyyy hh:mm:ss"

For example, the following two markers would produce a two line .csv file as shown:
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mk41149.5595988657,-2.1991799999203,56.9600300036883,Possible Wreck Site,4,Red Flag,
   28/08/2012 13:25:51
mk41149.5605201736,-2.19877999992026,56.9598200036882,WARNING! ROCKS,4,Rock,
   28/08/2012 13:27:48
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Glossary
.bmp The standard filename extension for bitmap images.

.kml The standard filename extension for a Keyhole Markup
Language file which contains georeferencing data. This file
will either be incorporated within a .kmz file or requires an
accompanying image file (with the same file name) to be valid.
Used by Google Earth.

.kmz The standard filename extension for a compressed file containing
the Keyhole Markup Language file (.kml) and image file. For
storing georeferencing data and images in a single file. Used by
Google Earth.

.mrk The standard filename extension for marker files exported from
Seanet Pro, saved as a text file in tabular format with table cells
separated by commas.

.png The standard filename extension for Portable Network Graphics
- a bitmapped image format employing lossless compression.

.tiff or .tif The standard filename extension for Tagged Image File Format.

.v4log The standard file format used by Seanet Pro log files.

ASCII American Standard Code for Information Interchange - a
character encoding scheme originally based on the English
alphabet.

CD-ROM Compact Disc - Read Only Memory

CSV Comma Separated Value - a text file in tabular format with table
cells separated by commas, usually given the filename extension
.csv but this can vary depending on the application.

GeoTiff A public domain standard file format which allows
georeferencing information to be embedded into a TIFF (Tagged
Image File Format) image, uses the filename extension .tif or
.tiff.

Google Earth A virtual globe, map and geographical information program,
originally called EarthViewer 3D prior to being acquired by
Google Inc. in 2004.

GPS Global Positioning System.

Hammerhead A survey sonar produced by Tritech International Ltd and part
of the SeaKing range. Capable of producing very high resolution
sonar images which can then be loaded into the Sonar Image Tiler
software as part of a site survey.
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JPEG or JPG Joint Photographics Expert Group - a compression method and
file format for image files, files can be stored with either .jpeg
or .jpg file extensions

MicronNav An Ultra Short Baseline (USBL) system for location and
tracking of ROVs, divers, etc. Consists of the MicronNav 100
surface control unit (similar to the SeaHub but with different
functionality) a "dunking transducer" which is mounted on the
vessel/dockside under the waterline and a responder which is
mounted on the ROV or Hammerhead tripod.

NMEA National Marine Electronics Association - a USA based
standards association responsible for overseeing electrical and
data communications standards between marine devices (due
to become the IMEA or International Marine Electronics
Association in 2012).

PC Personal Computer

SCU Surface Control Unit - a specially manufactured computer which
is rack mountable and capable of processing the data from
the sonar equipment running either Windows XP Embedded or
Windows 7 and Seanet Pro or Gemini software.

SeaKing A specific sonar produced by Tritech International Ltd but also
refers to the family of sonar equipment manufactured by Tritech
International Ltd comprising of the SeaKing, SeaKing DST
scanning and profiling sonars and the Hammerhead survey sonar.

Seanet Pro The software supplied by Tritech International Ltd which is
capable of running all the sonar devices.

Sidescan A sonar that is typically towed behind a boat or mounted to the
side of an ROV which takes a series of narrow sonar images that
are joined together to form strips. Typically used for survey work.

USBL Ultra Short Base Line (positioning system)

UTM Universal Transverse Mercator coordinate system - a 2-
dimensional Cartesian coordinate system to give locations on the
surface of the Earth.

WGS84 World Geodetic System (1984 revision) - a standard for use in
cartography, geodesy and navigation and used as the reference
coordinate system by GPS devices.

world file A file used by the Tritech Sonar Image Tiler program which
is designed to accompany an image file and contains geo-
referencing data. The file format will have different extensions
depending on the format of the image file:
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Image type World file
extension

.bmp .bpw

.jpg or .jpeg .jgw

.tif or .tiff .tfw

.png .pgw

XML Extensible Markup Language. A markup language and file
format that is designed to be both human and machine readable.
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